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Intro 
 

The Layer Properties dialogue is accessed by right clicking on the desired layer 

in the layer control. It is where you can edit and set various things regarding that 

specific layer: 
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Bottom Buttons 
 

In changing anything in the Layer Properties, clicking OK will save the changes 

and close the dialogue. The Apply button however allows you to apply the 

changes to the layer without closing the dialogue, so you can first see how it 

looks and then change if necessary or save it. Cancel of course will cancel what 

you were doing and close the dialogue: 

 

 

 

We will take up all the different tabs of this dialogue: 

 

General 
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In the General tab we can set some general things regarding our layer. First is 

Description which is the name of the layer. Underneath that we can choose to 

have Display layer ticked on or off; as it says, if ticked on it will display on the 

map otherwise it will just hold data; normally if your layer didn’t have any ge-

ometries or coordinates then you would have this ticked off. Reload will reload 

the layer for you if this was needed to refresh anything: 

 

 

 

Display from Scale is where you can choose from what scale to what scale is 

the data displayed on the map; when you are out of this scale range on your 

map, the data will not be displayed. Transparency is how transparent the ele-

ments in the layer are when they are displayed: 
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Selectable is whether the elements in the layer can be selected in the scene or 

not. Snappable is whether you can snap to the elements in the scene or not us-

ing one of the snap tools. Editable is whether graphics in this layer can be ed-

ited or not, if this ticked off then you won’t be able to add, delete or change any-

thing in the layer. Include in Legend is whether to show this layer in the scene 

legend (if you have the legend turned on). Background Layer is whether you 

want this set as a background layer or not: 

 

 

 

Read Only will make the layer settings read only. Data Read Only will make 

just the data of the layer read only. Publish is whether to publish this layer or 

not when publishing to a Geoscope file. Publish Readonly will publish the 

layer settings read only and Publish Data Readonly will publish the data as 

read only: 

 

 

 

Mnemonic Display allows you to choose a certain image to be displayed next to 

the layer in the layer control, to do this you click Change, to remove the image 

click Clear: 
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Data 
 

 

 

In the Data tab you can set various things regarding the data in the layer. You 

can choose what kind of layer it is by Layer type; we support various kinds of 

layers: 
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Under Settings, different dialogues will exist depending on the layer type, if 

your layer type is None, which is the case if you are adding a new layer, you 

will have the following dialogue: 
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In the Columns tab, you can edit and create columns for the layer that will form 

the layer data grid. To create a predefined data grid, choose one from the 

dropdown and then click the Create button; Simple will make just a simple ge-

ometry column for the grid and geometries will then be able to be drawn to the 

layer; With ID etc. adds an ID column etc. as well: 

 



Layer Properties User Guide 

9 

 

 

 

 

 

To edit and add columns, simply click in the grid (and make sure Edit Columns 

is ticked on): 
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(Note: To edit or add new columns to an existing layer you would usually do 

this via the layer data grid for the layer and not here, this is normally for when 

creating a new layer to set up its layer data grid.) 

 

You can also edit the column type, you can even choose to make a column Im-

age type which will store images for each record: 
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In the layer data grid of this layer, you would then just click on the cell in the 

column and then right click to load an image: 
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In the Initialization tab you can choose a layer to copy from and set up an ex-

pression, to initialize values in the new layer you are creating. Here I am initial-

izing values from my Areas layer, giving the new layer the same geometries and 

the ID values of Areas layer times two: 
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Insert Column inserts a column from the new layer (which you created in the 

Columns tab) so that its value can be set. Insert Column Access inserts a col-

umn from the layer you are copying from to get its value. Insert Calculation 

will insert any of a range of predefined calculations for you: 
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An example of another settings dialogue is for a layer of the SpatialVU type. In 

this dialogue you can choose the file path for the layer and also what columns 

you would like to have shown in the layer data grid: 
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A useful feature of file paths for certain files in SpatialXL is that a relative refer-

ence for them can be created. As long as the file is stored together with the Ex-

cel workbook in the same location, it doesn’t matter if you move this, it will still 

correctly reference the file. For example: 

 

 

 

If I move all these files together to the desktop, the Sub Places SVU file will still 

be correctly referenced when I open the Excel workbook. A relative reference is 

indicated by the pipe symbol: 
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Clicking Optimize SVU File will optimize it for viewing. The Protection but-

ton will show you data about the file if it has been protected (locked to ma-

chine/expiry set: 

 

 

 

Geometry Extraction will bring up a dialogue where you can specify how you 

want the geometry extracted from this layer:  
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Choose other extraction options from the dropdown: 
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The dialogue when creating a layer that uses a SQL Server database looks as fol-

lows. You can enter in your credentials or use Integrated Security and then 

choose the Server and Database. In the Command box you can enter in your 

database query: 

 

 

 

You can test the connection to the database with Test Connection: 
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Geometry Extraction will bring up a dialogue where you can specify how you 

want the geometry extracted from this layer:  
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Choose other extraction options from the dropdown: 
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You can also use Query Builder to build a query. Clicking on it will bring up 

the Query Builder box: 
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Right clicking on a table, you can choose to browse the data in it with Browse 

Data: 
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If the table has what you want, you can then click Add to add this table to your 

query; this will bring up a box where you can tick on the columns in this table 

you would like to query: 
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I’ve chosen to select all from this table. Your query is shown at the bottom as 

you construct it. You can also choose to do an aggregation on the data, sort it in 

a certain way etc. in the grid above: 
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When done you can then click Execute to see the results of the query: 
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If you are happy with the results, you can then exit the Query Results box and 

then click OK: 
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The dialogues for Oracle etc. data base layers look and work similarly. 

 

Autoload, Fit on Autoload and Dynamic Load have the following functions: 
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Connections is where you can manage shared connections for sublayers, for ex-

ample here is a South Africa map layer. South Africa is the top containing 

layer and where the connection is created; each of the SVU files(sublayers) con-

tained in this layer use this same predefined connection. This is convenient so 

that if the layer loader is changed (the connection) for the layer I don’t have to 

change it in each sublayer I can just manage it in one place in the top-level layer: 
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As you can see in the Connections dialogue a connection has been set up called 

Shape. The loader for the file and the path of the SVU file base folder is de-

fined.  

Protected will show you data on whether the file is protected (locked to ma-

chine/expiry date). Geometry Extraction allows you to choose a geometry ex-

traction for the SVU file if necessary. 

 

If I go to the Layer Properties of one of the sublayers you will see it is using this 

predefined connection (called Shape): 

 

 

 

Styling 
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In the Styling tab you can set various things relating to the style and appearance 

of the layer. In the Basic tab are the basic things you can set about the layer’s 

appearance such as Colour, Size etc.: 

 

 

 

This is how my layer then appears: 
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You can also have predefined settings that you set up which you can use at any 

time again, this is done by clicking the palette icon to the right, which brings up 

the following dialogue (this feature can be found in the Thematics tab and Text 

tab and is used in the same way): 
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To add the predefined settings, first set it up in the Layer Properties box as 

you’d like then click the plus icon and name it how you’d like: 
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You can then choose to Export these settings so they can be loaded at a later 

time, otherwise they are just saved in this dialogue so you will see it there each 

time you open it: 
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Load will load the exported settings and replace any current predefined settings 

you have in the dialogue whereas Append will add them to the list. 

 

To apply these settings, you click the tick icon: 

 

 

 

Advanced is where you can save and load all predefined settings for all dia-

logues, for which predefined settings can be saved such as Styling and Themat-

ics. It is saved as a settings package and when loaded will overwrite any cur-

rently predefined settings in all the Saved Settings dialogue boxes: 
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When loading a settings package, you will get the following message: 

 



Layer Properties User Guide 

41 

 

 

 

Under Images and Icons you can choose to have images displayed for the 

points in your scene: 

 

 

 

For the Default Image I will browse to the image I want: 
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And for Selected Image I will do the same; Selected Image is the image to be 

shown when points are selected in the scene: 
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The images can be scaled on the side: 

 

 

 

I can then click OK, and you will see the images displayed for the points in my 

scene: 
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And if I select one of them it will change to the selected image I set: 
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You can also use characters/symbols instead of images by using the Char but-

ton: 
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You can align the images etc. using the controls here: 
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Under Line Images you can choose to have images displayed at the beginning 

or end of linestrings as an indicator of a beginning or end point, you similarly 

browse to the image or character you want and scale it: 
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You can align the images with the line or choose to have only end image shown 

if line closed: 

 

 

 

Under Grid Objects you can choose the default and selected display style for 

grid layers: 
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Text 
 

 

 

In the Text tab you can set various things regarding text labels shown on your 

scene. In the Basic tab you can choose what column in your data you would like 
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to show text labels for. You can also choose what scale to display it at, position-

ing etc.: 

 

 

 

In the Effects tab you can set the style, font, size etc. for the text; you can see an 

example of some settings I set, below is a sample of how the text will look: 
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To change the font, colour and size of text click on Font & Colour which will 

bring up a dialogue box: 
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When done setting your text click OK and you will see your labels in the scene: 
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For Text you similarly have a predefined settings feature that you can access 

with the palette icon and works as gone over under Styling: 
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Thematics 
 

 

 

In the Thematics tab you can create various themes for your layer. This is gone 

over in the SpatialXL Guide, Theming section. Here I will cover ones that 

weren’t touched on, starting with Thickness/Size. In this tab you can create a 

theme that will make the points or elements bigger in the layer depending on 

their value in some column in the layer data. For example, I will choose the TO-

TAL VOLUME column to do this on: 

 

https://primethought.biz/help/spatialxl/spatialxlhelp/index.html
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Minimum value to map and Maximum value to map can be auto set based on 

the values in your layer by using the Autoset button. You can then set the Min 

and Max Thickness(mm) for the elements: 
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Click OK (or Apply first to see how it looks) when done and your theme is ap-

plied: 
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With the Heat Map tab you can create a heat map theme. First, choose the col-

umn in your data you would like to do this for by Heat map column.  Then by 

Aggregation choose what type of calculation you would like done in aggregat-

ing the values (Note: you can also save predefined settings for this, indicated by 

the palette icon on the right, as gone over under Styling): 
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Then you can change the colours for the map if you’d like by clicking on them. 

Flip Colours will change it around so that the highest value colour is the lowest 

value colour and vice versa. Clear Colours will clear the colours from the box 

and Default Colours will set the colours back to the default if changed. If you 

tick on Advanced you can make the heat map more precise by increasing the 

number of cells it uses: 
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Click OK (or Apply first to see how it looks) when done and your theme is ap-

plied: 
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Under Charts you can set up a theme that will show charts for the elements in 

your layer. You can choose between Bar and Pie Chart: 
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In the case of a Bar Chart it has the following dialogue. First, make sure to 

have Show Charts ticked on so that any charts you set will show. Then you can 

set your desired Chart Width and Chart Height. In the Chart tab you can then 

set the various properties of the chart, a Preview of the chart is shown on the 

left: 
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In the Bars tab you will choose the columns in your data you would like to use 

as bars in the chart: 
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After choosing each column click Add to add it as a bar: 

 

 

 

You can then set various properties for each bar (first click on the bar you want 

to edit in the box). Then calculate the range of the data for the bar by clicking 

Calculate. To remove any bar you can click Remove: 
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Click OK (or Apply first to see how it looks) when done and your theme is ap-

plied: 
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A Pie Chart theme is set up as follows. Make sure Show Charts is ticked on so 

the chart will be displayed, then set Chart Width and Chart Height. Click on 

the row in the grid area under Ring Width and choose the width for the first 

ring of the chart (you can then choose its Border Colour and Border Width): 
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Now click below the row and you will see there is now a plus symbol which you 

should expand. Choose the column in your data for this part of the chart (you 

can then choose its Fill Colour etc.). In the row below choose the next column 

to include in your pie chart, as usual you will see a preview of the chart on the 

left as you create it: 
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You can then collapse this row and then click in the row below and follow the 

same steps to add another ring if you’d like: 
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Click OK (or Apply first to see how it looks) when done and your theme is ap-

plied: 
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Scene Tips is fully described in the Scene Tips manual. 

 

Links 
 

The Links tab is where you can set up links between layers. For tighter and 

more direct links where you want to create a direct relation you would use the 

Relations tool (see Relations manual): 

 

 

 

To create a link click Add Link. Then Name it and choose the Target of the 

link, which is the layer you’re linking to. Your links are shown in the box to the 

left: 

 

https://primethought.biz/help/spatialvu/scene_tips
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Next choose the column/s in the current layer (Link Column) that you will be 

using to link to the target layer. Then choose the corresponding column/s in the 

target layer (Target Column). Ticking on Hide if unlinked will hide graphic 

data in source or target data that is unlinked, meaning elements that don’t share 

a common value: 
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You can now click OK and your layers are now linked. In this example I linked 

my Points layer to my Areas layer, and as an example of using this link I can 

now theme my Points layer on a column from my Areas layer: 
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Projection 
 

In the Projection tab you can choose a layer projection for your layer. SRID 

stands for Spatial Reference Identifier and is a unique identifier associated with 

a specific coordinate system, tolerance, and resolution. How the SRID is popu-

lated or what it represents can vary depending on what database you use to store 

your data: 
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You can tick on Well known text to show the well known text of the projection 

and enable editing of it:  
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If you have defined your own layer projection while editing the Well known text 

you can click Add predefined and then this will be added to the Predefined 

layer projections list that you can access at the bottom: 

 

 

 

The Manage Projections for sublayers button will take you to a dialogue 

where you can set up projections for sublayers (layers within layers). This pro-

vides a central location where projections for all sublayers can be managed: 
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Click New to add a projection for sublayers, then in the dialogue that comes up, 

name it and enter in the Well Known Text for the projection, then click OK: 
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The projection has been added. You can Validate it then if you want which will 

bring up a properties box where you can see if all is good with it: 
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Now, if you go to the Layer Properties of any sublayer you will see you have an 

option to choose this projection for it in the Predefined layer projections: 
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Input Transform 
 

In the Input Transform tab you are able to enter a transform to be done on the 

layer. There are various transforms to choose from. To access these, right click 

in the Transforms box and then Insert and then choose the desired transform: 
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You can save these transforms to file either individually or as a group. Load 

File will load a group of transforms saved, but to load a single saved transform 

you would use From File: 
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Event Scripts 
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Event Scripts is fully covered in the Event Scripts manual. 

 

Editing 
 

In the Editing tab you can choose to have the Edit Form dialogue come up when 

adding new features to the layer, this will allow you to choose the values in the 

layer data for the new element added. By Edit form column count you can 

choose how many columns you would like to have the columns from your data 

split into on the form: 

 

 

 

I will draw a new point to this layer to demonstrate. Once I’ve drawn the point it 

brings up the Edit Form and here I can enter in the desired values for this new 

element: 

 

https://primethought.biz/help/spatialvu/event_scripts
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All Properties 
 

In the All Properties tab is an easy way to search and edit all properties in one 

place: 
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Colour Palette 
 

The Colour Palette can be accessed from the Layer Properties box as well ( in 

addition to in the View tab) and how it works is covered fully in the View Tab 

Guide Colour Palette section: 
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